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1.  INTRODUCTION

The RCM5700 and RCM6700 are compact modules in a mini PCI Express form factor, and incor-

porate the powerful Rabbit® 5000 and 6000 microprocessors with integrated 10/100Base-T Ether-

net functionality and onchip SRAM. The Rabbit® 5000 and 6000 microprocessor features include 

hardware DMA, I/O lines shared with up to six serial ports and four levels of alternate pin func-

tions that include variable-phase PWM, an external I/O bus, quadrature decoder, and input cap-

ture. This equates to a MiniCore module that is fast, efficient, and the ideal solution for a wide 

range of embedded applications.

Development Kits are available with the essentials that you need to design your own microproces-

sor-based system, and includes a complete Dynamic C software development system. The Devel-

opment Kit also contains an Interface Board with USB and Ethernet connections that will allow 

you to evaluate the RCM5700 or RCM6700, and a Prototyping Board to help you to develop your 

own applications. You will also be able to write and test software for the RCM5700/RCM6700 

modules, including Ethernet applications.

The RCM5700 has a Rabbit 5000 microprocessor operating at up to 50.0 MHz, flash memory, 

two clocks (main oscillator and real-time clock), and the circuitry necessary to reset and manage 

the Rabbit 5000. The RCM6700 has a Rabbit 6000 processor operating at up to 187.5 MHz and 

1MB of internal SRAM. An edge connector brings out the MiniCore module user interface to a 

52-pin mini PCI Express socket on the motherboard the core module is mounted on.

The RCM5700/RCM6700 receives its +3.3 V power from the motherboard on which it is 

mounted. The MiniCore module can interface with other CMOS-compatible digital devices 

through the motherboard.
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1.1  RCM5700/RCM6700 Features

� Small size: ranges from 1.20" × 2.00" × 0.12" (30 mm × 51 mm × 3 mm) for the RCM5700/

RCM6700 model to 1.20" × 2.00" × 0.73" (30 mm × 51 mm × 19 mm) for the RCM5760/

RCM6760 model

� Microprocessor: RCM5700:  Rabbit 5000 running at 50.0 MHz, RCM6700: Rabbit 6000 run-

ning at 187.5 MHz

� Up to 35 general-purpose I/O lines each configurable with up to four alternate functions

� 3.3 V I/O lines

� Six CMOS-compatible serial ports — four ports are configurable as a clocked serial port (SPI), 

and two ports are configurable as SDLC/HDLC serial ports

� Ethernet PHY interface chooses Ethernet interface automatically based on whether a crossover 

cable or a straight-through cable is used in a particular setup

� External I/O bus can be configured for 8 data lines, 8 address lines (shared with parallel I/O 

lines), and I/O read/write

� RCM5700:  128KB SRAM (on Rabbit 5000 chip) and 1MB flash memory, with 2MB serial 

flash and 512KB SRAM on RCM5750/RCM5760 models.

RCM6700:  1MB SRAM (on Rabbit 6000 chip) and 1MB serial flash, with 4MB serial flash 

and additional 1MB external SRAM on RCM6750/6760 models.

� Real-time clock (battery-backable on all models except the RCM5750/5760)

� Watchdog supervisor

There are four RCM5700 production models. Table 1-1 summarizes their main features.
 

Table 1-1.  RCM5700 Features

Feature RCM5700 RCM5710 RCM5750 RCM5760

Microprocessor Rabbit 5000 at 50.0 MHz

Ethernet Port
10/100Base-T 

PHY only

10/100Base-T, 

RJ-45, 2 LEDs

10/100Base-T 

PHY only

10/100Base-T, 

RJ-45, 2 LEDs

External SRAM — 512KB (8-bit)

SRAM 128KB (Rabbit 5000 onchip)

Flash Memory (program) 1MB

Flash Memory
(mass data storage)

— 2MB (serial flash)

Serial Ports

6 shared high-speed, CMOS-compatible ports:
6 are configurable as asynchronous serial ports;
4 are configurable as clocked serial ports (SPI);
2 are configurable as SDLC/HDLC serial ports;
1 asynchronous serial port is used during programming
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The RCM5700 and RCM5750 models already have an Ethernet PHY device, the Integrated Cir-

cuit Systems ICS1893BK. The RCM5710 and RCM5760 are identical to the RCM5700 and 

RCM5750 respectively, except that they have an integrated 10/100 Base-T magnetic RJ-45 jack 

with two LEDs on the MiniCore printed circuit board.

There are four RCM6700 production models. Table 1-2 summarizes their main features.

Table 1-2.  RCM6700 Features

Feature RCM6700 RCM6710 RCM6750 RCM6760

Microprocessor Rabbit 6000 at 162.5 MHz

Ethernet Port
10/100Base-T 

PHY only

10/100Base-T, 

RJ-45, 2 LEDs

10/100Base-T 

PHY only

10/100Base-T, 

RJ-45, 2 LEDs

External SRAM — 1MB (16-bit)

RAM NOTE: 1MB (Rabbit 6000 onchip)

SRAM 32KB (Rabbit 6000 onchip, battery-backable)

Flash Memory
(mass data storage)

1MB (serial flash) 4 MB (serial flash)

Serial Ports

6 shared high-speed, CMOS-compatible ports:
6 are configurable as asynchronous serial ports;
4 are configurable as clocked serial ports (SPI);
2 are configurable as SDLC/HDLC serial ports;
1 asynchronous serial port is used during programming

The Rabbit 6000 has an Ethernet PHY built into the processor. The RCM6710 and RCM6760 are 

identical to the RCM6700 and RCM6750 respectively, except that they have an integrated 10/100 

Base-T magnetic RJ-45 jack with two LEDs on the MiniCore printed circuit board.

Placing the RJ-45 Ethernet jack on the motherboard, which is what must be done with the 

RCM5700/RCM6700 and RCM5750/RCM6750 models, provides significant design advantages 

because the core module may then be placed anywhere on the motherboard. Rabbit’s Technical 

Note TN266, PCB Layout for the Ethernet PHY Interface, provides complete design recommen-

dations. If the RJ-45 Ethernet jack is on the MiniCore printed circuit board, as it is on the 

RCM5710/RCM5760/RCM6710/RCM6760 modules, the edge of the MiniCore module with the 

Ethernet jack must be positioned along the edge of the motherboard to allow access to the jack 

since the entire assembly will likely be inside a customer-designed enclosure.
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All RCM5700/RCM6700 models are programmed through a USB connector on the motherboard 

using a USB cable supplied with the Development Kit. The RCM5750/RCM5760 may also be 

programmed remotely over an Ethernet link using the Remote Program Update library with 

Dynamic C v. 10.56 or later. The RCM67xx series may also be used with the Remote Program 

Update with Dynamic C v. 10.64 or later. See Application Note AN421, Remote Program Update, 

for more information.

NOTE:  The RabbitLink cannot be used to program the RCM5700 or RCM6700.

Appendix A provides detailed specifications for the RCM5700 and RCM6700.

1.2  Advantages of the RCM5700 and RCM6700

� Fast time to market using a fully engineered, “ready-to-run/ready-to-program” microprocessor 

core.

� Competitive pricing when compared with the alternative of purchasing and assembling indi-

vidual components.

� Easy C-language program development and debugging

� Rabbit Field Utility to download compiled Dynamic C .bin files.

� Generous memory size allows large programs with tens of thousands of lines of code, and sub-

stantial data storage.

� Reference design allows integrated Ethernet port for network connectivity, with royalty-free 

TCP/IP software.



MiniCore RCM5700/RCM6700 User’s Manual digi.com 9

1.3  Development and Evaluation Tools

1.3.1  Standard Development Kit

The RCM5700/RCM6700 Standard Development Kit contains the hardware essentials you will 

need to use your RCM5700 or RCM6700 module. These items are supplied in the standard ver-

sion of the Development Kit.

� RCM5700 or RCM6700 module.

� Interface Board with standoffs/connectors.

� Prototyping Board with standoffs/connectors.

� USB cable to program MiniCore via Interface Board.

� Dynamic C CD-ROM, including product documentation on disk.

� Getting Started instructions.

� Registration card.

 

Figure 1-1.  Standard Development Kit

1.3.2  Deluxe Development Kit

In addition to the items included in the standard Development Kit, the Deluxe Development Kit 

contains the following items.

� Universal AC adapter, 5 V DC, 2 A (includes Canada/Japan/U.S., Australia/N.Z., U.K., and 
European style plugs). Development Kits sold in North America may contain an AC adapter 
with only a North American style plug.

� Digital I/O and Serial Communication accessory boards for use with certain sample programs.

� CAT 5/6 Ethernet cable and DB9 to 10-pin header serial cable.

� Rabbit 5000 or 6000 Processor Easy Reference poster.



MiniCore RCM5700/RCM6700 User’s Manual digi.com 10

1.3.3  Software

The RCM5700/RCM5710 is programmed using version 10.44 or later of Dynamic C; the 

RCM5750/RCM5760 requires version 10.56 or later of Dynamic C; and the RCM6700 family 

requires version 10.64 or later. A compatible version is included on the Development Kit 

CD-ROM. 

In addition to the Web-based technical support included at no extra charge, a one-year telephone-

based technical support subscription is also available for purchase. For further information and 

complete documentation, contact your Rabbit sales representative or authorized distributor, or 

visit our Web site at www.digi.com.

1.3.4  Online Documentation

The online documentation is installed along with Dynamic C, and an icon for the documentation 

menu can be placed on the workstation’s desktop. Double-click this icon to reach the menu. If the 

icon is missing, use your browser to find and load default.htm in the docs folder, found in the 

Dynamic C installation folder.

The latest versions of all documents are always available for download from our web site.
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2.  GETTING STARTED

This chapter describes the RCM5700/RCM6700 hardware in more detail, and explains how to set 

up and use the accompanying Interface Board.

NOTE: This chapter (and this manual) assume that you have the RCM5700/RCM6700 

Development Kit. If you purchased an MiniCore module by itself, you will have to adapt 

the information in this chapter and elsewhere to your test and development setup.

2.1   Install Dynamic C

Dynamic C must be installed to develop and debug programs for the RCM5700/RCM6700 series 

of modules (and for all other Rabbit hardware). The latest version of Dynamic C is included on 

CD in the Development Kit and is also available for download on our website at www.digi.com.

If you have not yet installed Dynamic C, do so now by inserting the Dynamic C CD from the 

Development Kit in your PC’s CD-ROM drive. If autorun is enabled, the CD installation will 

begin automatically.

If autorun is disabled or the installation does not start, use the Windows Start | Run menu or Win-

dows Disk Explorer to launch setup.exe from the root folder of the CD-ROM.

The installation program will guide you through the installation process. Most steps of the process 

are self-explanatory.

Once your installation is complete, you will have up to three new icons on your PC desktop. One 

icon is for Dynamic C, another opens the documentation menu, and the third is for the Rabbit Field 

Utility, a tool used to download precompiled software to a target system.

If you have purchased any of the optional Dynamic C modules, install them after installing 

Dynamic C. The modules may be installed in any order. You must install the modules in the same 

folder where Dynamic C was installed.
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2.2  Hardware Connections

There are three steps to connecting the Interface Board for use with Dynamic C and the sample 

programs:

1. Insert standoffs/connectors on the Interface Board.

2. Install the MiniCore module on the Interface Board.

3. Connect the USB cable between the Interface Board and the workstation PC.

2.2.1  Step 1 — Prepare the Interface Board for Development

Insert a short plastic standoff supplied from the Development Kit in one of the corner holes from 

the bottom of the Interface Board, then secure it with a long plastic standoff from above as shown 

in Figure 2-2. Repeat this step so that plastic standoffs/connectors are in place at all four posi-

tions.

 

Figure 2-2.  Insert Standoffs/Connectors
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2.2.2  Step 2 — Install Module on Interface Board

Position the MiniCore module with the edge connectors facing the mini PCI Express socket J1A at 

an angle as shown in Figure 2-3 below. Insert the edge connectors into the mini PCI Express 

socket J1A, then press down on the opposite edge of the MiniCore module to snap it into place in 

holder J1B.

 

Figure 2-3.  Install the MiniCore Module on the Interface Board
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Should you need to remove the MiniCore module, use two fingernails to hold back the spring clip 

at J1B from the two MiniCore corners, lift up the edge of the MiniCore above J1B, then pull the 

MiniCore away to remove the edge connectors from the mini PCI Express socket.

 

 

CAUTION: 
Remove power before attempting to insert or remove the MiniCore in 

the mini PCI Express socket.
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2.2.3  Step 3 — Connect USB Cable

The USB cable connects the RCM5700/RCM6700 to the PC running Dynamic C to download 

programs and to monitor the MiniCore module during debugging. It also supplies power to the 

Interface Board and the MiniCore via the USB interface.

Connect the USB cable between USB connector J5 on the Interface Board and your PC as shown 

in Figure 2-4. Note that the USB cable connectors are different at either end, so there is only one 

way to connect them between the PC and the Interface Board.

 

Figure 2-4.  Connect USB Cable

Your PC should recognize the new USB hardware, and the LEDs next to the USB connector on 

the Interface Board will flash — if you get an error message, you will have to install USB drivers. 

Drivers for Windows XP are available in the Dynamic C Drivers\Rabbit USB Programming 

Cable\WinXP_2K folder — double-click DPInst.exe to install the USB drivers. Drivers for 

other operating systems are available online at www.ftdichip.com/Drivers/VCP.htm.

The green power LED on the Interface Board should light up when you connect the USB cable. 

The MiniCore and the Interface Board are now ready to be used.

NOTE: A RESET button is provided on the Interface Board above the Ethernet jack to allow a 

hardware reset without disconnecting power.

NOTE: Pins 1–2 on header JP1 on the Interface Board must be jumpered to download and debug 

applications and sample programs with Dynamic C running. Pins 1–2 should be left 

unjumpered to run an program already loaded in flash memory.

CAUTION: Do not jumper pins 1–3 on header JP1 on the Interface Board.



MiniCore RCM5700/RCM6700 User’s Manual digi.com 16

2.2.3.1  Alternate Power Supply Connections — Deluxe Development Kit

The deluxe Development Kit contains a separate AC adapter that may be used to supply power to 

the Interface Board and the RCM5700/RCM6700 when the USB cable is not connected or when 

more power is needed than the 500 mA the USB cable is able to supply. The AC adapter may also 

be used to supply power when the USB cable is connected, in which case the power supply 

through the USB cable will be disconnected automatically. 

 

Figure 2-5.  Alternate Power Supply Connections—Deluxe Development Kit

First, prepare the AC adapter for the country where it will be used by selecting the plug. The 

deluxe Development Kit presently includes Canada/Japan/U.S., Australia/N.Z., U.K., and Euro-

pean style plugs. Snap in the top of the plug assembly into the slot at the top of the AC adapter as 

shown in Figure 2-5, then press down on the spring-loaded clip below the plug assembly to allow 

the plug assembly to click into place. Release the clip to secure the plug assembly in the AC 

adapter.

Connect the AC adapter to DC input jack J6 on the Interface Board as shown in Figure 2-5. Plug 

in the AC adapter. The green power LED on the Interface Board should light up. The MiniCore 

and the Interface Board are now ready to be used.

Note that the center pin of J6 is positive.
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2.3  Starting Dynamic C

If you already have Dynamic C installed, you are now ready to test your programming connec-

tions by running a sample program. Start Dynamic C by double-clicking on the Dynamic C icon 

on your desktop or in your Start menu. Select Store Program in Flash on the “Compiler” tab in 

the Dynamic C Options > Project Options menu. Then click on the “Communications” tab and 

verify that Use USB to Serial Converter is selected to support the USB cable. Click OK.

You may have to select the COM port assigned to the USB cable on your PC. In Dynamic C, select 

Options > Project Options, then select this COM port on the “Communications” tab, then click 

OK.

2.4  Run a Sample Program

Find the file PONG.C, which is in the Dynamic C SAMPLES folder. To run the program, open it 

with the File menu, compile it using the Compile menu, and then run it by selecting Run in the 

Run menu. The STDIO window will open on your PC and will display a small square bouncing 

around in a box.

This program shows that the CPU is working.

2.4.1  Troubleshooting

If you receive the message Could Not Open Serial Port, check that the COM port assigned 

to the USB cable was identified and set up in Dynamic C as described above. This same error 

occurs when Windows has already allocated the COM port to another process.

If you receive the message No Rabbit Processor Detected, the USB cable may be con-

nected to the wrong COM port, or the connection may be faulty. First, check both ends of the USB 

cable to ensure that it is firmly plugged into the PC and the USB connector in the Interface Board. 

Ensure that the module is firmly and correctly installed in its connector on the Interface Board.

If Dynamic C appears to compile the BIOS successfully, but you then receive a communication 

error message when you compile and load a sample program, it is possible that your PC cannot 

handle the higher program-loading baud rate. Try changing the maximum download rate to a 

slower baud rate as follows.

� Locate the Serial Options dialog on the “Communications” tab in the Dynamic C Options > 

Project Options menu. Select a slower Max download baud rate. Click OK to save.

If a program compiles and loads, but then loses target communication before you can begin 

debugging, it is possible that your PC cannot handle the default debugging baud rate. Try lower-

ing the debugging baud rate as follows.

� Locate the Serial Options dialog on the “Communications” tab in the Dynamic C Options > 

Project Options menu. Choose a lower debug baud rate. Click OK to save.

Press <Ctrl-Y> to force Dynamic C to recompile the BIOS. You should receive a Bios compiled 

successfully message once this step is completed successfully. 
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2.5  Where Do I Go From Here?

If the sample program ran fine, you are now ready to go on to other sample programs and to develop 

your own applications. The source code for the sample programs is provided to allow you to modify 

them for your own use. The RCM5700/RCM6700 User’s Manual also provides complete hard-

ware reference information for the RCM5700/RCM6700, the Interface Board, the Prototyping Board, 

and the accessory boards in the Deluxe Development Kit.

For advanced development topics, refer to the Dynamic C User’s Manual.

2.5.1  Technical Support

NOTE: If you purchased your MiniCore through a distributor or through a Rabbit partner, contact 

the distributor or partner first for technical support.

If there are any problems at this point:

� Use the Dynamic C Help menu to get further assistance with Dynamic C.

� Check the Rabbit Technical Bulletin Board and forums at www.digi.com/support//forum/.

� Use the Technical Support e-mail form at www.digi.com/support/.
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3.  RUNNING SAMPLE PROGRAMS

To develop and debug programs for the RCM5700/RCM6700 (and for all other Rabbit hardware), 

you must install and use Dynamic C. This chapter provides a tour of its major features with 

respect to the RCM5700/RCM6700.

3.1  Introduction

To help familiarize you with the RCM5700/RCM6700 modules, Dynamic C includes several 

sample programs. Loading, executing and studying these programs will give you a solid hands-on 

overview of the RCM5700/RCM6700’s capabilities, as well as a quick start with Dynamic C as an 

application development tool.

NOTE: The sample programs assume that you have at least an elementary grasp of ANSI C. If 

you do not, see the introductory pages of the Dynamic C User’s Manual for a suggested reading 

list.

In order to run the sample programs discussed in this chapter and elsewhere in this manual,

1. Your RCM5700/RCM6700 must be installed on the Interface Board as described in Chapter 2, 

“Getting Started.”

2. Dynamic C must be installed and running on your PC.

3. The USB cable must connect the Interface Board to your PC.

4. Power must be applied to the RCM5700/RCM6700 through the Interface Board.

Refer to Chapter 2, “Getting Started,” if you need further information on these steps.

To run a sample program, open it with the File menu (if it is not still open), then compile and run 

it by selecting Run in the Run menu (or press F9). The RCM5700/RCM6700 must be in Program 

Mode (see Figure 4-12) and must be connected to a PC using the USB cable.

Complete information on Dynamic C is provided in the Dynamic C User’s Manual.
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3.2  Sample Programs

Of the many sample programs included with Dynamic C, several are specific to the 

RCM5700/RCM6700. These programs will be found in the SAMPLES\RCM5700 or 

SAMPLES\RCM6700 folder, depending on your MiniCore model. Sample programs in the 

SAMPLES folder one level up are generally generic samples that can be run on any Rabbit-based 

product.

Before you compile and run the following sample programs, make sure that pins 1–2, 5–6, and 7–

8 on header JP1 of the Interface Board are jumpered. Each sample program has comments that 

describe the purpose and function of the program. Follow the instructions at the beginning of the 

sample program.

CAUTION: Do not jumper pins 1–3 on header JP1 on the Interface Board.
 

 

� FLASHLED01.C—demonstrates the use of costatements to flash LED DS1 on the Interface 

Board. PD0 on the MiniCore is used to drive the LED.

� FLASHLED01A.C—demonstrates the use of a state machine with standard C constructs to flash 

LED DS1on the Interface Board. PD0 on the MiniCore is used to drive the LED.

� FLASHLED02.c—demonstrates the use of costatements to detect and debounce switch S1 

being pressed on the Interface Board. LED DS1 flashes on the Interface Board, and the rate at 

which it flashes changes each time you press switch S1. I/O control for the LED is provided by 

PD0 on the MiniCore, and PD1 detects the activity on switch S1.

� FLASHLED02A.c—detects and debounces switch S1 being pressed on the Interface Board. 

LED DS1 flashes on the Interface Board, and the rate at which it flashes changes each time you 

press switch S1. I/O control for the LED is provided by PD0 on the MiniCore, and PD1 detects 

the activity on switch S1.
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The Digital I/O accessory board needs to be installed to run the SWITCHLEDS.C and the SERIAL-

TOSERIAL.C sample programs. This accessory board is included only with the Deluxe Develop-

ment Kit.

To install the Digital I/O accessory board, insert the strip of header pins included with the acces-

sory board into the socket at J12 on the bottom side of the Digital I/O accessory board. Then line 

up the Digital I/O accessory board with the Interface Board standoffs/connectors and install the 

Digital I/O accessory board pins into socket J2 on the Interface Board. Secure the Digital I/O 

accessory board with the long plastic standoffs/connectors from above as shown in Figure 3-6.

 

Figure 3-6.  Install Digital I/O Accessory Board 

Pins 1–2, 3–4, 5–6, and 7–8 on headers JP5 and JP8 on the Digital I/O accessory board must be 

jumpered. Pins 2–4 and 3–5 on header JP7 on the Digital I/O accessory board must also be jum-

pered.

� SWITCHLEDS.C—monitors switches S1, S2, S3, and S4 on the Digital I/O accessory board and 

lights LEDs DS1–DS4 when the corresponding pushbutton switch is pressed. LEDs DS1–DS2 

on the Digital I/O accessory board are controlled by PA4–PA7, and switches S1–S4 are con-

trolled by PB4–PB7 respectively.
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The SERIALTOSERIAL.C sample program is in the SAMPLES\RCM5700\SERIAL or 

SAMPLES\RCM6700\SERIAL folder, depending on your MiniCore model.

� SERIALTOSERIAL.C—monitors switches S1, S2, S3, and S4 on the Digital I/O accessory 

board and lights LEDs DS1–DS4 when the corresponding pushbutton switch is pressed. LEDs 

DS1–DS2 on the Digital I/O accessory board are controlled by PA4–PA7, and switches S1–S4 

are controlled by PB4–PB7 respectively. The sample program sends messages from Serial Port 

D to Serial Port C to indicate that a switch was pressed. Messages received by Serial Port C are 

displayed in Dynamic C’s STDIO window.

Before you compile and run this sample program, you will need to connect J2 pin 19 (PC0/TxD) 

to J2 pin 22 (PC3/RxC) or the corresponding holes on P2.

 

If you are using the Serial Communication Accessory Board, you should connect pin 3 (TXD) on 

header J3 to pin 5 (RXC) on header J4 instead.
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The Serial Communication accessory board needs to be installed to run the following serial sam-

ple program in the SAMPLES\RCM5700\SERIAL or SAMPLES\RCM6700\SERIAL folder, depend-

ing on your MiniCore model. This accessory board is included only with the Deluxe Development 

Kit.

To install the Serial Communication accessory board, insert the strip of header pins included with 

the accessory board into the socket at J12 on the bottom side of the Serial Communication acces-

sory board. Then line up the Serial Communication accessory board with the Interface Board or 

Digital I/O accessory board standoffs/connectors and install the Serial Communication accessory 

board pins into socket J2 on the Interface Board or the Digital I/O accessory board. Secure the 

Serial Communication accessory board with the long plastic standoffs/connectors from above as 

shown in Figure 3-6.

 

Figure 3-7.  Install Serial Communication Accessory Board 

Pins 1–2, 3–4, 5–6, and 7–8 on header JP5 on the Serial Communication accessory board must be 

jumpered. Pins 1–2 and 3–4 on header JP7 on the Serial Communication accessory board must 

also be jumpered.

� SIMPLE5WIRE.C—This program demonstrates 5-wire RS-232 serial communication with 

flow control on Serial Port C and data flow on Serial Port D.

To set up the Serial Communication accessory board, you will need to tie TxD and RxD on the 

RS-232 header at J3, then tie CTS and RTS, also on J3, using jumpers as shown in Figure 3-7.

Once you have compiled and run this program, you can test flow control by disconnecting the 

CTS jumper from RTS while the program is running. Characters will no longer appear in the 

STDIO window, and will display again once CTS is connected back to RTS.
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Once you have loaded and executed these sample programs and have an understanding of how 

Dynamic C and the RCM5700/RCM6700 modules interact, you can move on and try the other 

sample programs, or begin developing your own application.

3.2.1  Use of Serial Flash (not supported for RCM5700/RCM5710)

The following sample programs from the SAMPLES\RCM5700\Serial_Flash folder may be used 

with the RCM5750/RCM5760 models.

� SERIAL_FLASHLOG.C—This program runs a simple Web server and stores a log of hits on the 

home page of the serial flash “server.” This log can be viewed and cleared from a browser at 

http://10.10.6.100/. You will likely have to first “configure” your network interface card for a 

“10Base-T Half-Duplex,” “100Base-T Half-Duplex,” or an “Auto-Negotiation” connection on 

the “Advanced” tab, which is accessed from the control panel (Start > Settings > Control 

Panel) by choosing Network Connections.

� SFLASH_INSPECT.C—This program is a handy utility for inspecting the contents of a serial 

flash chip. When the sample program starts running, it attempts to initialize a serial flash chip 

on Serial Port B. Once a serial flash chip is found, the user can perform five different com-

mands to print out the contents of a specified page, print out the contents of a range of pages, 

clear (set to zero) all the bytes in a specified page, set all bytes on the specified page to a given 

value, or save user-specified text to a selected page.
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4.  HARDWARE REFERENCE

Chapter 4 describes the hardware components and principal hardware subsystems of the 

RCM5700/RCM6700. Appendix A, “RCM5700/RCM6700 Specifications,” provides complete 

physical and electrical specifications.

Figure 4-8 shows the Rabbit-based subsystems designed into the RCM5700/RCM6700.

 

Figure 4-8.  RCM5700/RCM6700 Subsystems
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